Technical note 2014/01
The SAP 2012 module

1 Introduction

This technical note outlines the main changes to the interface of the JPA Designer SAP
2012 module for Part L 2013 for England, compared to the SAP 2009 module. The user
manual for JPA Designer will be revised to include the SAP 2012 module. Note that the
compliance arrangements for Part L 2014 for Wales (coming into force at the end of July
2014) will differ from those for Part L 2013 in England (in force from 6 April 2014).

This note does not describe the changes to compliance arrangements.

2 Managing SAP 2012 calculations

To start a new SAP 2012 calculation go to the Insert menu in the Project Manager window
and select Dwelling/SAP (V9.92 2012) calculation.
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Figure 1: A SAP 2009 and its associated SAP 2012 calculation

To convert a SAP 2009 calculation to SAP 2012:



1. Select the calculation to convert in the Project Manager window.

2. From the Edit menu select Copy selected SAP V9.90 2009 dwelling to a v9.92 2012
dwelling.

3. A new SAP 2012 calculation is created, based on the existing one. It's name is the
same as the original, but with - SAP 2012 Version 9.92 added to the end (Figure 1)).

Note: To convert a SAP 9.81 calculation to SAP 9.92 you must first convert it to
SAP 9.90.

SAP 2012 calculations are opened in the same way as other calculations by double-
clicking their name in the calculation list.

3 Main SAP window

The main SAP window is largely unchanged: the only new items being the Dwelling
Fabric Energy Efficiency (DFEE) and Target Fabric Energy Efficiency (TFEE) values which
are displayed alongside the TER and DER (see Figure 2)). In order for a dwelling to comply
with Part L 2013 the DFEE must be equal to or smaller than the TFEE and the DER equal
to or smaller than the TER.
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Figure 2: The key results for SAP 2012 on the toolbar

4 Project Information and Options dialogue

There are no changes to the data entered in this dialogue. However, you must now enter
at least the first block of the post code. If you do not the program will show an error.

This is a result of a change to using post code based, local climate data for calculation
of EPC ratings and improvements: without a valid post code the program is unable to
calculate the EPC figures.



5 SAP worksheet

The data for the SAP calculation is still entered through the SAP Worksheet values dia-
logue. The order of the tabs and the general arrangement of the dialogue are unchanged.

5.1 Dimensions

There are no changes in the data required for the dwelling dimensions.

5.2 Ventilation

The only change in data entry for the Ventilation tab is an expansion of the boxes for
specifying chimneys and flues. They can now be assigned to main heating, secondary
heating or other systems (see [Figure 3). However, it is still the total number which goes
forward to the SAP calculation.
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Figure 3: The expanded ventilation selection

5.3 Walls, roofs and floors

There are no changes to the definition of elements, but there has been a small change
in the Calculate Htb dialogue, where the Junction type column now shows the junction
reference number, e.g. E14. The numbers match those in SAP 2012 Appendix K and
Appendix R.

5.4 Openings

As a result of change in the method of calculating solar gain the calculation now requires
the pitch of a rooflight when it is between 0 and 70°. The pitch is entered in the Pitch
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linear thermal | linear thermal (m} transmittance x
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E10 Eaves (ingulation at ceiling level) [4]

E12 Gable (insulation at ceiling level) [A] 0.240 0.240 15.200 3648

Figure 4: Reference numbers for junction types

box (Figure 5) on the Doors, Windows and Rooflights dialogue for each roof light. The
pitch should be measured to the nearest 5°.

The pitch data only affects solar gain calculations and has no effect on the U-value of the
roof light.
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Figure 5: New box for rooflight pitch data

5.5 Water heating

The Water heating tab has changes to the treatment of primary pipework and solar thermal
systems.

5.5.1 Primary pipework

The calculation of losses from primary pipework (the pipework separating a source of
domestic hot water from a storage vessel) has been revised and assessors must record the
extent to which the pipework is insulated. The requirement applies to indirect cylinders
and stores connected by uninsulated pipework or more than 1.5 m of insulated pipework:
that includes

* hot water storage tank with boiler feed;

e community heating scheme;

e multi-point water heater;

¢ boiler with thermal store;
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Figure 6: The Primary insulation list
e CPSU.

The Primary insulation (Figure @) offers four levels for the insulation level of primary
pipework.

5.5.2 Solar panels

There are two changes to the treatment of solar thermal panels which heat domestic hot
water. First, the calculation method for panels has changed, following a move to use data
conforming to BS EN 12975--2; the heat loss from the collector is now assessed by two
heat loss coefficients, which should improve the accuracy of results for panels with less
insulation and a sharper efficiency curvell.

The solar panel data now includes a new field: second order collector heat loss coef-
ficient (see Figure 7). The data for the second order coefficient should be provided on
any data sheet for panels products The value will be small, typically around 0.01-0.04.
If you are using the default data for panels which is built into JPA Designer the program
will still complete all the data fields for the panels.

"For an explanation of the change see: http:/www.viridiansolar.co.uk/Briefings/Solar_Panel_Efficiency
_in%20SAP_2009_Second_Order_Coefficients.pdf
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Figure 7: The new 2nd order collector heat loss coefficient box

In a second change, the benefit of water heating by solar thermal panels is now adjusted
according to the type of showers present in the dwelling. The data is entered by selecting

a value from the new Showers list (Figure ). Values are:

e No shower (bath only)

Non-electric shower(s) only

Both electric and non-electric showers

Electric showers only

The selection here is separate from any data entered for a Waste Water Heat Recovery
System.
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Figure 8: The Showers list



5.5.3 Dedicated community hot water systems

It is now possible to enter a calculated distribution loss value for a community heating
scheme which provides only domestic hot water. To enter a calculated value:

1. In the Distribution list select Calculated (item 1 in Figure 9).
2. Enter the loss figure in the adjoining box (item 2 in Figure 9).
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Figure 9: Setting a calculated distribution loss

5.6 Primary heating tab

There are a number of minor changes on the Primary heating tab.

5.6.1 Two main heating systems

Where dwellings have two main heating systems there is now an option for both systems
to share the same central heating pump. This is indicated with a new tick box: System 2

uses System 1’s pump (see Figure 10). Ticking the box will slightly reduce electricity use
and emissions.
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Figure 10: Setting two heating systems to share one pump



5.6.2 Central heating pumps

There are two other changes to the data for central heating systems with pumps:

e The item Central heating pump in heated space has been reworded (previously it
was Pump in heated space).

e There is a new box Central heating pump 2013 or later (item (2) in Figure 11)),
which should be ticked for a new dwelling. Ticking the box will reduce the energy
use for pumps and fans and reduce internal heat gains from the pump.

5.6.3 Design flow temperature

In SAP 2012 the use of wet heating systems with low distribution temperatures brings
improvements in the operating efficiency of condensing boilers. sets out the
percentage improvements in efficiency associated with different temperatures. The im-
provements only apply to condensing boilers. The improvements associated with load
and weather compensators are obtained from the PCDF record for the compensator.

Table 1: Efficiency adjustments for design flow temperatures

Boiler features Efficiency adjustment (%)
Natural gas  Oil/LPG

Load and/or weather compensator as database

Flow temperature limited to 45°C +2.4 +1.6

Flow temperature limited to 35°C +3.0 +2.0

Boiler with thermal store 0 0

The temperature is set using the new Design flow temperature in the Primary heating tab
(item (3) in Figure 11). Where there flow temperature is not limited to 45°C or there is no
data you should select >45°C rather than unknown.

Reducing the design flow temperature will improve (reduce) the DER.

5.6.4 Heating controls

The Heating controls have also been expanded, with a new option for heating controls by
device from database. This is to address compatibility of control devices with the chosen
boiler.

In a minor revision of the software, the Source of Efficiency section is only displayed once
the System has been specified.
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Figure 11: Changes to heat emitter inputs

5.6.5 Boiler efficiency

For gas and oil boilers it is no longer acceptable to use a manufacturer’s declared SEDBUK
value for the as-built submission: the efficiency must either be the default value, or be
taken from the PCDF (the boiler database).

5.6.6 Heat pumps

Where a heat pump which is not listed in the PCDF (the ‘database’) is installed under
the Microgeneration certification scheme the default efficiency values given in SAP Table
4a are increased by installation factors which reflect the improved efficiency obtained by
complying with the MIS installation standard MIS 3005. The factors, may only be applied
when an MCS certificate has been supplied to the assessor by the installer.

To apply the installation factors in the SAP 2012 module tick the MCS installed heat pump
box ((Figure 12).

5.6.7 Community heating schemes

It is now possible to use a calculated values for the distribution loss factor for community
heating schemes where the default conditions given in Table 12c of the SAP document
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Figure 12: Indicating a heat pump is installed to the MCS
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Figure 13: Entering a calculated distribution loss factor

To apply calculated loss factor:

1. From the Heat distribution system list select Calculated (item 1 in Figure 13).
2. Enter the loss factor in the adjoining box (item 2 inFigure 13).

The method of calculating a distribution loss factor is set out in Appendix C3.1.

5.7 PV & Alt Tech

It is now possible to enter three different sets of PV panels. A new tick box is used to
indicate if the output from the panels is connected to the electricity meter in the dwelling.
This is to implement the conditions for SAP 2012 Appendix M1 for flats. Where panels
are connected to the dwelling’s meter the PV output will affect CO, and SAP ratings,
otherwise the output of the panels only affects CO, ratings.
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Figure 14: PV panels connected to electricity meter

10



6 Viewing results

The number of reports available via the View menu and the Sections to print dialogue
has increased to include the following worksheets:

* EPC ratings;

e TER;

e DER;

e Compliance checklist;

e Overheating;

e DFEE;

e Standard case (CSH ENE7);

¢ Heat demand;

e EPC costs.

The Sections to print dialogue also includes the Input data report.

7 Further information

Information about JPA Designer may be found at http://www.techlit.co.uk.
Technical support by email only to support@techlit.co.uk.

© JPATL Ltd 2014
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